utoCAD Land Desktop 2009 Network Administrator's Guide >
Jluick Start to Network Administration

Network deployment of this program requires careful planning and execution.
This section gives you quick, step-by-step instructions about how to prepare for
deployment, set up a license server, and set up and distribute the program.

If you are not familiar with network administration and deployment, you should
read the entire Network Administrator's Guide before you attempt to deploy and
administer the program over a network.

This guide applies to both versions of Land Desktop (AutoCAD Land Desktop
2009 and AutoCAD Land Desktop Companion 2009).

Topics in this section

=  How to Prepare for Deployment
= How to Set Up a License Server

= How to Set Up and Distribute the Program

m  Features That Require Design Review
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low to Prepare for Deployment

To prepare for a deployment, you need to choose an installation type and a
license server model.

Topics in this section

=  How to Choose an Installation Type

= How to Choose a License Server Model
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low to Choose an Installation Type

When you set up your deployment, you need to choose the type of installation to
deploy. In the AutoCAD Land Desktop 2009 Installation wizard, you specify
one of the following installation types:

Network License installation

With this type of installation, you install the program to workstations with the
files and registry entries that allow the program to communicate with the
Network License Manager. You also define the configuration of the Network
License Manager so that the licenses can be accessed. Workstations running
the program based on a network installation do not require individual
activation. Licensing of this program is managed by at least one license
server.

The main advantage is that you can install AutoCAD Land Desktop on more
systems than the number of licenses you have purchased (for example,
purchasing 25 licenses but installing on 40 workstations). At any one time,
AutoCAD Land Desktop runs on the maximum number of systems for which
you have licenses. This means you get a true floating license.

Multi-Seat Stand-Alone installation (Stand-Alone option)

Choose this type of installation for stand-alone installations where a single
serial number is used for multiple seats. Multi-seat stand-alone installations
do not rely upon a Network License Manager to manage product licenses;
however, you can still use the AutoCAD Land Desktop 2009 Installation
wizard to create administrative images and create deployments. Registration
and activation is more automated for multi-seat stand-alone installations.
After the first activation using the multi-seat stand-alone serial number,
activation occurs automatically for all workstations based on this
deployment, as long as your systems are connected to the Internet.



Stand-Alone installation (Stand-Alone option)

Choose this type of installation for stand-alone installations where a single
serial number is used for a single seat. Like a multi-seat stand-alone
installation, you do not use the Network License Manager to manage product
licensing, but installation, registration, and activation occurs on each
workstation.

If you choose one of the Stand-Alone installation types, you can proceed to the
section How to Set Up and Distribute the Program.
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low to Choose a License Server Model

If you chose the Network Installation option, you need to decide which license
server model to use to distribute the product licenses.

Tip If you are deploying a stand-alone or multi-seat stand-alone installation type,
you do not use a license server model. Proceed to the How to Set Up and
Distribute the Program section.

For the network installation, use one of the following license server models:

= Single license server model. The Network License Manager is installed
on a single server, so license management and activity is restricted to
this server. A single license file represents the total number of licenses
available on the server.

»  Distributed license server model. Licenses are distributed across more
than one server. A unique license file is required for each server. To
create a distributed license server, you must run the Network License
Manager on each server that is part of the distributed server pool.

= Redundant license server model. You use three servers to authenticate
a single license file. One server acts as the master, while the other two
provide backup if the master server fails. With this configuration,
licenses continue to be monitored and issued as long as at least two
servers are still functional. The license file on all three servers is the
same. You must install the Network License Manager on each server.

Each of these license server models is described in detail in the Network
Licensing Guide. It is strongly recommended that you read that guide before you
deploy the program. You can find the Network Licensing Guide by clicking the
Documentation link at the lower left corner of the AutoCAD Land Desktop 2009
Installation wizard and in the Help system.
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If you are planning to have users run the program using network licenses, you
need to use the Network License Manager and the Network License Activation
utility.

The Network License Manager helps you configure and manage license servers.
The Network License Activation utility helps you get licenses and register them
over the Internet.

Topics in this section

=  How to Install the Network License Manager

m  How to Install and Use the Network License Activation Utility
= How to Configure Your License Server
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low to Install the Network License Manager

The Network License Manager is used to configure and manage the license

Servers.

To install your Network License Manager

1.

In the AutoCAD Land Desktop 2009 Installation wizard, click Install
Tools and Utilities.

On the Select the Products to Install page, select Autodesk Network
License Manager and click Next.

Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

Note If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.

On the Review - Configure - Install page, review your product selection
and the current settings. If you don’t want to make any changes, click
Install. If you want to change the install type or installation path, click
Configure.

On the Select the Installation Type page, choose Typical or Custom and
accept the default installation path (C:\Program Files\Autodesk Network
License Manager\) or Browse to specify a different path. If you enter a
path that does not exist, a new folder is created using the name and
location you provide. Click Next.

warning Do not install the Network License Manager on a remote drive.
When you install the Network License Manager files, you must provide
a path to a local drive. You must specify the drive letter; the universal
naming convention (UNC) is not supported.



. On the Configuration Complete page, click Configuration Complete to
return to the confirmation page.

. On the Review - Configure - Install page, click Install.

. When the Installation Complete page displays, click Finish.
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low to Install and Use the Network License Activation

Itility

With the Network License Activation utility, you can obtain licenses over the
Internet, which saves time and effort in setting up a network-licensed version of
the program. In addition, you can register your product, get automated support
by email if you cannot obtain a license over the Internet, and save and migrate
license files automatically.

To install your Network License Activation utility

1.

In the AutoCAD Land Desktop 2009 Installation wizard, click Install
Tools and Utilities.

On the Select the Products to Install page, select Autodesk Network
License Activation utility and click Next.

Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

Note If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.

On the Review - Configure - Install page, review your product selection
and the current settings. If you don’t want to make any changes, click
Install. If you want to change the install type or installation path, click
Configure.

On the Select the Installation Type page, choose Typical or Custom and
either accept the default installation path (C:\Program Files\Autodesk
Network License Manager\Network License Activation Utility\enu\) or
Browse to specify a different path. If you enter a path that does not exist,



a new folder is created using the name and location you provide. Click
Next.

On the Configuration Complete page, click Configuration Complete to
return to the confirmation page.

On the Review - Configure - Install page, click Install.

When the Installation Complete page displays, click Finish.

To use your Network License Activation utility

1.

On the Start menu (Windows), click All Programs (or Programs) »
Autodesk » Network License Manager » AutoCAD Land Desktop 2009
Network License Activation Utility.

On the Obtain a Network License page, review how this utility works
and the requirements for using it, and then click Next.

On the Server Information page, enter the product serial number.

Note If you are modifying an existing license file or obtaining a new
license for an existing product, your previously entered information
might be displayed. Make sure that the serial number that is displayed is
the one you want to license. If it is not, enter the correct product serial
number.

In the License Server Model section, click a license server model. For
more information about each license server model, click the ? button.

In the Server Host Name box, enter a server host name or click the [...]
button to locate the name of each server you plan to use.

In the Host ID box, for each server host name you entered in the
previous step, click Lookup to have the utility automatically locate the
host ID for the server, or enter the host ID manually.

Note If your server has more than one network adapter, select the one that
corresponds to a physical network adapter. To determine which adapters
are physical, enter ipconfig /all at a Windows command prompt and
view the Description field above each physical address. If there is more
than one physical network adapter, you can use any one of them, as long
as it was listed when you ran ipconfig /all. Logical devices such as VPN
adapters, PPP adapters, and modems may be listed but are not usable for



10.

11.

12.

13.

14.

licensing.

If you chose Distributed Server in step 4, the Seats box is displayed. In
the Seats box, enter the number of seats for each license server, and then
click Next.

On the Confirm Server Information page, review the server information
you entered, and click Next.

If the Register and License Your Autodesk Product page is displayed, do
all of the following, and then click Next.

m In the This Product Is To Be Registered To option, select
Company or Individual.

» In the Select Country or Region section, select your country or
region of residence.

m In the Is This an Upgrade section, select Yes or No.

If the Registration Information page is displayed, enter your registration
information, and then click Next.

If the Confirm Information page is displayed, review your registration
information, and then click Next.

If the Connecting page is displayed, click Next to connect to the Internet
to obtain your network license.

On the Licenses Received page, in the Save License File for [computer
name] dialog box, enter the location where you want to save your license
file, or click Browse to navigate to the location.

Note It is recommended that you save your license file to the location
where you installed the Network License Manager.

If you have an existing license file from another Autodesk product,
select one of the following options:

= Insert the New License Information Into It. The new license
information is added into the existing license file.

= Overwrite the Existing License File. The entire contents of the
existing license file is replaced with the new license information.
Select this option only if you no longer require any part of the



15.
16.

existing license file contents.
Click Next.

On the License Activation Successful page, click Print to save a printed
copy of the license information, or click Done to complete the
transaction and exit the Network Activation utility.
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You configure a license server so that you can manage the Autodesk product
licenses you received when you ran the Network License Activation utility.
Configure the license server with the Imtools.exe utility.

To configure your license server

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1. Do one of the following:

m Click Start menu (Windows XP & 2000) » All Programs (or
Programs) » Autodesk » Network License Manager »
LMTOOQOLS.

m Right-click the LMTOOLS icon (Windows Vista) on the desktop
and click Run As Administrator.

2. In the Lmtools program, on the Service/License File tab, select the
Configure Using Services option.

3. Click the Config Services tab.

4. On the Config Services tab, in the Service Name list, select a service
name or do one of the following:

m If a service name is selected, verify that it is the one you want to
use to manage licenses.

m [f no service name exists, enter the service name you want to use
to manage licenses.

Note If you have more than one software vendor using FLEXIm® for



10.

11.
12.

13.

license management, the Service Name list contains more than one
option.

In the Path to Lmgrd.exe File box, enter the path to the Network License
Manager daemon (Imgrd.exe), or click Browse to locate the file.

By default, this daemon is installed in the \Program Files\Autodesk
Network License Manager folder.

In the Path to the License File box, enter the path to your license file, or
click Browse to locate the file.

In the Path to the Debug Log File box, enter a path to create a debug log,
or click Browse to locate an existing log file.

To run Imgrd.exe as a service, select Use Services.

To automatically start Imgrd.exe when the system starts, select Start
Server at Power Up.

Click Save Service to save the new configuration under the service name
you selected in step 4. Then click Yes.

Click the Start/Stop/Reread tab.
On the Start/Stop/Reread tab, do one of the following:

m If a service has not yet been defined for Autodesk, click Start
Server to start the license server.

m If a service for Autodesk is already defined and running, click
ReRead to refresh the Network License Manager with any
changes made to the license file or Options file.

The license server starts running and is ready to respond to client
requests.

Close Imtools.exe.
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Once you have prepared for deployment and you have used the Network License
Manager and the Network License Activation utility, you are ready to set up and
distribute this program by using the AutoCAD Land Desktop 2009 Installation
wizard and choosing a deployment method.

Topics in this section

= How to Create a Network Share

m  How to Use the Installation Wizard to Set Up a Deployment
m  How to Deploy This Program
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A network share is an installation folder that you make available to users'
computers on a network. You point users to this location to install the program.
Create a network share that will be used by the AutoCAD Land Desktop 2009
Installation wizard during the creation of a client deployment.

Note You must have Full Control permissions set for your shared folder when you
are creating your deployment images. Read permissions are necessary to access
the network share and administrative permissions on the workstation where the
program is deployed.

To create your network share

1.
2.

On the desktop of a network server, create a folder named Autodesk.

Right-click the Autodesk folder and click Share and Security (or
Sharing).

In the <folder name> Properties dialog box, Sharing tab, select Share
This Folder.

Specify a Share Name, such as Autodesk or MyDeployments, if
necessary.

Click the Permissions button. In the Permissions dialog box make sure
Full Control is active. Click OK.

In Vista, right-click the Autodesk folder and then click Share. In the
Properties dialog box select Sharing and then Advanced Sharing to share

the folder. Click the Permissions button to make sure Full Control is
active. Click OK.

These steps are important when creating your deployment images.



6. Click OK or Close to close the Properties dialog box.

7. For each product you plan to install, create a subfolder in the Autodesk
folder. Name each folder with the pertinent product name.
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You can create a deployment directly from the AutoCAD Land Desktop 2009
Installation wizard. From the deployment, users can install the program on their
computers.

Note The following procedure illustrates just one of the ways you can set up a
deployment. This procedure details a single-server network deployment with a
Typical client setup type and no customizations. For further information about
setting up deployments, see Use the Installation Wizard to Set Up a Deployment.

To use the Installation wizard to create a default deployment

1. In the AutoCAD Land Desktop 2009 Installation wizard, click Create
Deployments.

2. On the Begin Deployment page, specify:

m Administrative image location. In the administrative image field,
enter an existing shared network location where you want to
create an administrative image, or click the Browse button to
navigate to a location where there is a shared network location.
Users install the program from this location.

Note If you do not know how to create a network share, see How
to Create a Network Share.

m Deployment name. In the deployment name field, enter a
deployment name. The name you enter here is the name of the
shortcut your users will access to install the product.

m If your target workstations run on 32- or 64-bit operating systems.
Under This Is To Be A, choose whether your deployment is going
to be installed on 32-bit or a 64-bit target operating system. This



selection does not identify the system your deployment was
created on; it identifies your target system.

Click Next.

. On the Select the Products to Include in the Deployment page, choose
the products you want to deploy and click Next.

Note AutoCAD Design Review 20009 is not installed by default when you
install AutoCAD. Some AutoCAD features require that Design Review
be installed to work properly. Design Review is the replacement viewer
for DWF Viewer. For more information about the affected features, see
Features That Require Design Review

. Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

Note If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.

. On the Product and User Information page, enter your serial number and
user information and click Next.

Important The information you enter here is permanent and is displayed in
the AutoCAD Land Desktop 2009 window (accessed by Menu browser
» Help » About) on your computer. Because you can't change this
information later without uninstalling the product, make sure you enter
the correct information now.

. On the General Deployment Settings page, choose if you want the
deployment to create a network log and/or a client log, run the client
installation in silent mode, and if you want users to participate in the
Customer Involvement program.

m When you choose to create a network log file, you also have to
specify where the log file is created by entering either a valid
UNC (universal naming convention) path or hard-coded path on
your network. The network log file is optional.

Note The folder where the network log resides must be a shared
folder where users who install the program have Change
permissions. Otherwise, successes or failures for user installations
cannot be written to the log file.



» Choose whether you want a client log file created.

» [f you want to prevent users from changing installation settings
when they install, select Silent mode.

» If you choose participation in the Customer Involvement
program, Autodesk sends helpful information about the product.

For more information regarding log files, refer to Specify Log File
Locations.

Click Next.

7. On the Review - Configure - Create Deployment page, click Create
Deployment.

By clicking Create Deployment, an administrative image is created in
the shared folder using the deployment options listed in the Current
Settings field.

8. On the Deployment Complete page, click Finish.

To use the Installation wizard to create a configured deployment

1. In the AutoCAD Land Desktop 2009 Installation wizard, click Create
Deployments.

2. On the Begin Deployment page, specify:

» Administrative image location. In the Administrative Image field,
enter an existing shared network location where you want to
create an administrative image, or click the Browse button to
navigate to a location where there is a shared network location.
Users install the program from this location.

Note If you do not know how to create a network share, see How
to Create a Network Share.

» Deployment name. In the Deployment Name field, enter the new
deployment name. The name you enter here is the name of the
shortcut your users will access to install the product.

m If your target systems are 32 or 64-bit operating system. Under
This Is To Be A, choose whether your deployment is to be
installed on a 32-bit or a 64-bit target operating system. This



selection does not identify the system your deployment was
created on; it identifies your target systems.

Click Next.

. On the Select the Products to Include in the Deployment page, choose
the product(s) you want to deploy and click Next.

Note AutoCAD Design Review 20009 is not installed by default when you
install AutoCAD. Some AutoCAD features require that Design Review
be installed to work properly. Design Review is the replacement viewer
for DWF Viewer. For more information about the affected features, see
Features That Require Design Review

. Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

Note If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.

. On the Product and User Information page, enter your serial number and
user information and click Next.

Important The information you enter here is permanent and is displayed
in the AutoCAD Land Desktop 2009 window (accessed by Menu
browser » Help » About) on your computer. Because you can't change
this information later without uninstalling the product, make sure you
enter the correct information now.

. On the General Deployment Settings page, choose if you want the
deployment to create a network log and/or a client log, run the client
installation in silent mode, and if you want users to participate in the
Customer Involvement program.

m When you choose to create a network log file, you also have to
specify where the log file is created by entering either a valid
UNC (universal naming convention) path or hard-coded path on
your network. The network log file is optional.

Note The folder where the network log resides must be a shared
folder where users who install the program have Change
permissions. Otherwise, successes or failures for user installations
cannot be written to the log file.



» Choose whether you want a client log file created.

» [f you want to prevent users from changing installation settings
when they install, select Silent mode.

» If you choose participation in the Customer Involvement
program, Autodesk sends helpful information about the product.

For more information regarding log files, refer to Specify Log File
Locations.

Click Next.

. On the Review - Configure - Create Deployments page, click Configure
to make changes to the administrative image.

. On the Select the License Type page, select a Stand-alone or Network
license installation.

. On the Select the Installation Type page, you can choose to make the
following configuration changes:

m Typical - Installs the most common application features.

m Custom - Installs only the application features that you select
from the Select Features To Install list:

CAD Standards Contains tools for
reviewing design
files for compliance
with your standards.

Database Contains database
access tools.

Dictionaries Contains
multilanguage
dictionaries.

Drawing Encryption Allows you to use
the Security Options
dialog box to
protect a drawing



with a password.

Express Tools

Contains AutoCAD
Land Desktop
support tools and
utilities.

Fonts

Contains program
fonts. (True Type
fonts are
automatically
installed with the
program.)

Autodesk Impression Toolbar

Allows you to
quickly export any
view to Autodesk
Impression for
advanced effects.

Content Search

Adds the content
search functionality.

Material Library

Contains over 300
professionally built
materials to apply to
a model.

New Features Workshop

Contains animated
demos, exercises,
and sample files to
help users learn new
AutoCAD features.

Portable Licence Utility

Contains portable
license management
tools.

Reference Manager

Allows you to view
and edit the paths of
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11.

12.

13.

externally
referenced files
associated with a
drawing.

Samples Contains various
feature sample files.

Tutorials Contains product
lessons.

VBA Support Contains Microsoft
Visual Basic for
Applications

support files.

Note Autodesk Impression availability is limited. Please check
your local Autodesk website to see if Impression is available in
your country.

m Product Install Path - Specifies the drive and location where
AutoCAD Land Desktop will be installed.

Click Next to proceed with the configuration process.

On the Define Search Paths and File Locations page, define search paths,
file names, and file locations, and then click Next.

warning Do not remove the DRV path and always add paths as secondary
paths.

To include additional files in the deployment, select their location and
file names on the Install Additional Files page. After making your
selections, click Next.

On the Specify User Preferences page, decide if the Internet Explorer
browser is required, set the default profile name, and whether or not you
want a desktop shortcut. Click Next.

On the Include Service Packs page, if service packs are available for
your deployment, you can select to include them.

The installer automatically checks autodesk.com for available updates. If
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15.

16.

17.

18.

updates are available, a link is displayed. If no updates are available a
link is not displayed.

On the Configure InfoCenter Communications Center page, you choose
to allow users access to the latest information and product discussions by
enabling live updates from Autodesk, Information and CAD Manager
channels and RSS feeds. After making your choices, click Next.

You can also allow users access to online tools such as DesignCenter,
error reporting and InfoCenter searches on the Configure Access to
Online Resources page. Make your selections, and then click Next.

On the Configuration Complete page, select another product tab to
configure another product and then click Next, or click Configuration
Complete to review your choices.

On the Review - Configure - Create Deployment page, click Create
Deployment.

On the Deployment Complete page, click Finish.
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You can choose from several methods of deploying the program. Network
sharing is the default method.

m  Network Share. Users launch the program with the shortcut icon that
you created with the Installation wizard, in step 3 of the procedure How
to Use the Installation Wizard to Set Up a Deployment. The program is
installed on users' local computers, and a product icon appears on their
desktop.

Note Users must have Read permissions to access the network share and
administrative permissions on the workstation where this program is
installed.

m  Scripting. See Use Scripts to Deploy the Program.

= Group Policy Objects (GPOs). See Use Group Policies to Install a
Deployment.

» Imaging Software. See Distribute the Product Using Imaging Software.
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Design Review is a tool for reviewing and working with DWF files. DWF files
are drawing files that have been converted so they can be transported over the
Internet and then shared with others. In order to work with DWF files, you need
to have Design Review installed.

If you want to use any of the following commands or functions with a DWF file,
you need to have Design Review installed.

= PUBLISH
= PLOT
= 3DDWF

= PUBLISH TO WEB
s EXPORT

= MARKUP

= DWFUNDERLAY
= AUTOPUBLISH

= SSM
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This section contains the system requirements for the location of the
administrative image that you create, the network license server, and the client
workstation.

Topics in this section

=  System Requirements for This Program

Please send us your comment about this page
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Before you begin installing the program on a network, make sure that your
servers and client workstations meet the minimum recommended hardware and
software requirements for a deployment.

See the following tables for administrative image, license server, and client
workstation system requirements.

Hardware and software requirements for the location of the
administrative image

Hardware/

Requirement Notes

Software 9

Hard disk 1 GB or above The location where you create
(recommended) the administrative image must

be a shared location so that
users can access the
administrative image.

Hardware and software requirements for the network license server

Hardware/ Software Notes

Operating system Windows Vista 32- The Network
bit License Manager

Windows XP 32-bit  Supports Ethernet



Windows 2003 network
Server Edition configurations only.

Windows 2000
Professional

Windows 2000
Server Edition

Computer/processor Pentium III or faster
450 Mhz
(minimum)

Network interface card Compatible with The Network
existing Ethernet License Manager
network supports multiple
infrastructure network interface

cards.

Communication protocol TCP/IP The Network

License Manager
uses TCP packet
types.

Hardware and software requirements

Hardware/ .

Software Requirement Notes

Operating 32-Bit It is recommended that non-English

system Windows Vista language versions of AutoCAD Land

Enterprise Desktop be installed on an operating
. . system with a user interface language
Windows Vista

. that matches the code page of the
Business AutoCAD Land Desktop language. A
Windows Vista code page provides support for



Web
browser

Processor

RAM

Graphics
card

Ultimate

Windows XP
Professional,
Service Pack 2

The 64-bit versions
of Windows XP and
Windows Vista are
supported only in
the 32-bit
compatibility mode.

32-bit

Internet Explorer
6.0 SP1 or later

32-bit

Intel® Pentium® 4,
2.0 GHz or faster,

AMD® Athlon™,
2.0 GHz or faster,

or

Intel or AMD Dual
Core processor, 1.6
GHz or faster

32-bit
1GB

1280 x 1024 32-bit
color video display

character sets used in different
languages.

You cannot install AutoCAD Land
Desktop if Microsoft Internet
Explorer 6.0 with Service Pack 1 (or
later) is not installed on the
installation workstation. You can
download Internet Explorer from the
Microsoft website:
http://www.microsoft.com/downloads/

= Requires a Windows-
supported display adapter.


http://www.microsoft.com/downloads/

adapter (True m  For graphic cards that support

Color) 128 MB or Hardware Acceleration,
greater, OpenGL®- DirectX 9.0c, or later, must be
or Direct3D®- installed.

capable,

m Installing from the LDT.msi
file does not install DirectX
9.0c, or later. Manual

workstation class
graphics card.

For Windows Vista, installation of DirectX is

a Direct3D capable required, in this circumstance,
workstation class for Hardware Acceleration to
graphics card with be configured.

128 MB or greater

is required1024 x

768 VGA with True

Color (minimum)

Hard disk 2 GB

Pointing Mouse, trackball, or
device other device

DVD- Any speed (for
ROM installation only)
Optional Printer or plotter
hardware Digitizer

Modem or access to
an Internet
connection

Network interface
card
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utoCAD Land Desktop 2009 Network Administrator's Guide >
leploy the Program

In this section, you’ll find more detailed information about using the Installation
wizard to create or modify deployments.

Topics in this section

m  Preliminary Tasks for a Network Deployment

m  Use the Installation Wizard to Set Up a Deployment
=  Point Users to the Administrative Image

»  Uninstall the Program
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Installing this program on a network requires careful planning and execution.
The deployment checklist gives you a quick summary of the type of information
you should be familiar with during your deployments.

Deployment Checklist

You have reviewed the system requirements.
O You must make sure that your network,
servers, and client workstations meet the
system requirements. See System
Requirements for This Program.

You have closed all other programs and
3 disabled anti-virus software. See Minimize
Chances of Installation Failure.

You have identiied where deployments will
(3 reside such as a shared folder for each

program you plan to deploy. See Create

Shared Folders for Your Deployments.

You have installed and activated any
O supporting tools and utilities. See Install and
Activate Tools and Utilities.

If your deployment plan involves using

O imaging software to distribute your
program(s) to client workstations, you have
reviewed the Distribute the Product Using

Imaging Software section.




You have specified whether you want to
create log files that contain deployment and
installation data, run silent mode, and
participate in the Customer Involvement
Program. See Specify Log File Locations.

You understand the type of license you’ve
purchased. If you plan a network license
deployment, you should also be familiar
with the type of license server model you
want to use and the license server name(s).
See Select a License Type (optional).

You know which type of installation you’ll
perform—typical or custom. See Select the

Installation Type (optional).

You may want to set search paths to custom
files or file locations that may have changed
in this release of software. See Define
Search Paths and File L.ocations (optional).

You have decided if you want to include
additional files with your deployment such
as drawing files, AutoLISP routines, or
script files. See Install Additional Files

(optional).

You have checked for service packs that
might be available for your product. If a
service pack is available, you’ve
downloaded it and extracted an MSP file.
See Include Service Packs (optional).

You have configured access to
Communication Center. Live Update
notifications let you know when product
updates are posted and configuring
Communication Center lets users access



technical information. See Configure
InfoCenter Communication Center

(optional).

You have set up access and participation in
O features like DesignCenter Online,

Subscription Center, and Customer Error

Reporting. See Allow Users to Access

Online Resources (optional).

You know how you’re going to personalize

O the program(s) during registration. Using
consistent registration data is very important.
See Register the Product.

When you have completed these tasks, you are ready to create a deployment
from the Installation wizard.

Topics in this section

=  Minimize Chances of Installation Failure

= Create Shared Folders for Your Deployments

m Install and Activate Tools and Utilities
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Tinimize Chances of Installation Failure

The AutoCAD Land Desktop 2009 installation process may stop if some
applications, such as Microsoft Outlook or anti-virus programs, are running
when you are creating a deployment. Close all running applications and
temporarily disable virus checking utilities.
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reate Shared Folders for Your Deployments

Shared folders are required for both network license and multi-seat stand-alone
methods of installation. The shared folder (network share) is created before you
run the Installation wizard and is where product deployments are stored.

It is recommended that you name the network share folder Deployments on the
desktop of the system where you want deployments stored. You can then add
subfolders inside the shared Deployments folder that clearly convey the name of
product you plan to deploy. This is also beneficial if you plan to deploy multiple
products. For example:

Any subfolders that are placed inside a shared folder are automatically shared.

Tip You must have Full Control permissions set for your shared folder when you
are creating your deployment images. Read permissions are necessary to access
the network share and administrative permissions on the workstation where the

program is deployed.

To create a shared folder

1. On a network server, create a folder named Deployments.

2. Right-click the Deployments folder and click Share and Security (or
Sharing).

In Vista, right-click the Deployments folder and then click Share. Click
the Permissions button to make sure Full Control is active.

3. In the <folder name> Properties dialog box, Sharing tab, select Share
This Folder.

In Vista, in the Properties dialog box, select Sharing and then Advanced
Sharing.



. Specify a Share Name, such as MyDeployments, if necessary.

. Click the Permissions button. In the Permissions dialog box make sure
Full Control is active. Click OK.

. Click OK or Close to close the Properties dialog box.

. For each product you plan to install, create a subfolder in the
Deployments folder. Name each folder with the pertinent product name.
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1stall and Activate Tools and Utilities

Several supporting tools and utilities are necessary if you plan to have users run
the program(s) with network licenses. Ancillary programs you might install
include:

m  Network License Manager

m  Network License Activation Utility
m  CAD Manager Tools

m  SAMreport Lite

Refer to the Network Licensing Guide for detailed information about how to set
up your license servers. The Network Licensing Guide is available on the
Documentation link of the Installation wizard and in the Help system.
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'se the Installation Wizard to Set Up a Deployment

The deployment process is initiated from the Installation wizard. After
deployments are created, users can install the program on their workstations.
You make choices during the deployment process to create various client
deployment images and deployment types that meet user requirements and
company needs.

The deployment process lets you do any of the following:
m  Create a deployment.
= Apply a patch to a deployment.
m  Add customized files to a deployment.
m Change search paths and file locations.
m  Allow users access to online resources.

Note Because the deployment process provides you with numerous options for

creating and customizing your deployments, there are many deployment pages
you need to complete and choices you must make. You should set aside ample
time to complete the deployment process in one sitting.

Topics in this section

m  Start the Deployment Process

m  Create a Deployment

=  Enter Product and User Information

m  Specify Log File Locations




What Is Silent Mode?
Customer Involvement Program (CIP)

Select a License Type (optional)

Select the Installation Type (optional)

Define Search Paths and File L.ocations (optional)
Install Additional Files (optional)

Specify User Preferences (optional)

Include Service Packs (optional)

Configure InfoCenter Communication Center (optional)
Allow Users to Access Online Resources (optional)

Final Review and Complete Setup

Register the Product

Modify a Deployment (optional)
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tart the Deployment Process

Once you start the Installation wizard, you initiate the deployment process to set
up a deployment.

To start the deployment process

= In the AutoCAD Land Desktop 2009 Installation wizard, click Create
Deployments.
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reate a Deployment

A deployment contains a Microsoft Transform (MST) file that modifies the
default behavior of the installation program. As you begin a deployment, you
need to select the location of your Administrative image, a deployment name,
and if your target systems are 32 or 64-bit operating systems.

Begin Deployment
Specify the Administrative Image location:

Browse...

Spedfy the new deployment name:

This is to be a:

To create a deployment



. In the Installation wizard, click Create Deployments.

. On the Begin Deployment page, enter the location of your
Administrative image or click the Browse button to locate your image.
Enter your deployment’s name, and if your target systems are 32 or 64-
bit operating systems.

Note The deployment location should be a shared network folder. To
create a shared folder, see Create Shared Folders for Your Deployments.

. On the Select the Products to Include in the Deployment page, select the
products and click Next.

. Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the deployment.
Choose your country or region, click I Accept, and then click Next.

Note If you do not agree to the terms of the license and want to terminate
the deployment process, click Cancel.

. On the Product and User Information page, enter the serial number and
requested personalization data. Click Next.

. On the General Deployment Settings page, choose whether or not you
want to create a network log and its location, and a client log. You can
also run the client’s installation in silent mode and if you want users to
participate in the Customer Involvement Program. Click Next.

. If you do not want to make configuration changes on the Review -
Configure - Install page, click Create Deployment. Then select Yes in the
prompt, to continue installing using the default configuration.

. Select the Register products online link to register and activate your
product, or click Finish and register and activate later.
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nter Product and User Information

The Product and User Information page is used to personalize the program for
your company. The information you enter here is permanent and is displayed in
the About AutoCAD Land Desktop 2009 window (accessed by Menu browser »
Help » About) on all workstations that install your deployment. Because you
can't change this information later without uninstalling, make sure you enter the
correct information now.

Product and User Information

Serial number:

123 - 12345678

First name:

MyMame

Last name:

MyMame

Organization:

MyOrganization

You must also enter your product serial number in order to run the product. The
product serial number is located on the product packaging. The serial number
must contain a three-digit prefix followed by an eight-digit number.

To enter your serial number and personal information

1. On the Product and User Information page, enter your product serial



number and the requested personalization data.

Note Although it is required that you enter information in each box on
this page, you can enter any information that you want to convey to
users who install the deployment.

2. Click Next.
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pecify Log File Locations

The program has two types of log files with which you can monitor information
about deployments and installations.

General Deployment Settings

Log file

[¥] Create network log

Spedify the log file location:

YWy ComputerAutodesk<MyProduct = Browse, ..

[¥] Create dient log

The dient log is created in the "Temp” directory of each dient workstation,

Network log. The network log file keeps a record of all workstations
that run the deployment. On the General Deployment Settings page of
the deployment process, you choose whether or not to create a network
log file. The log lists the user name, workstation name, and the status of
the installation. Refer to this file for status information and details about
problems that users encountered during installation (for example, low
disk space or inadequate permissions). The network log is named with
the same name you chose for your deployment. You can specify where
the log file is created by entering either a valid UNC (universal naming
convention) path or hard-coded path on your network, for example
\\MyComputer\Autodesk\AutoCAD Land Desktop 2009.

Note The folder where the network log resides must be a shared folder
where users who install the program have Change permissions.
Otherwise, successes or failures for user installations cannot be written
to the log file.



= Client log. The client log contains detailed installation information for
each workstation. This information may be useful in diagnosing
installation problems. The client log is located in the \Temp directory of
each client workstation.

To specify a log file location

1. While creating a deployment, on the General Deployment Settings page,
select the check box next to the Create Network Log box. Enter the
name of the folder where you want the network log to be located.

2. If you want to create a client log, select the Create Client Log option.

3. Click Next.
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vhat Is Silent Mode?

When silent mode is active and a user initiates the deployment, the installation
proceeds without any explicit user input. No dialog boxes are presented that
require interaction from the user.

Silent mode

Client installations will be run in silent mode.
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ustomer Involvement Program (CIP)

If you choose to have your clients participate in the Customer Involvement
Program, AutoCAD Land Desktop will automatically sends Autodesk
information about system configuration, what features you use most, any
problems that you encounter, and other information helpful to the future
direction of the product.

Customer Involvement

Allow users to choose to participate in the Customer Involvement Program
(Recommended)

Note You can also enable or disable the Customer Involvement Program from the
CAD Manager Control utility.
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elect a License Type (optional)

When you set up your deployment, you choose the type of installation to deploy
based on the type of software license you purchased: stand-alone or network.
You also select the network license server model you want to use to distribute
product licenses.

Specify the license type to use during deployment

Stand-alone license (a single serial number for a single seat)

For a stand-alone license, you install, register, and activate the program on
each workstation.

Network license

With this type of installation, you install the program to workstations with the
files and registry entries that allow the program to communicate with the
Network License Manager. You also define the configuration of the Network
License Manager so that the licenses can be accessed. Workstations running
the program based on a network installation do not require individual
activation. Licensing of this program is managed by at least one license
server.

To deploy a stand-alone license

1. While creating a deployment, on the Select the License Type page, select
Stand-alone license.



Select the License Type

@) Stand-alone license

Metwark license

2. Click Next.

Specify the license server model during deployment

If you choose the Network license option, you need to decide which license
server model to use to distribute your product licenses - single, distributed or
redundant license server model.

If you are deploying a stand-alone or multi-seat stand-alone installation type,
you do not use a license server model. For more information on server models,
see How to Choose a License Server Model.

To deploy a network license using a single license server model

1. While creating a deployment, on the Select the License Type page, select
the Network License option.

2. Select Single License Server as the license server model you want to use
with the Network License Manager.

If you have already used the Network License Manager to create a
license server model, you must select the same license server model in
this step. If you have not yet used the Network License Manager to
create a license server model, make sure that you select the same settings
in the Network License Manager that you choose here.

For detailed information about license server models, see “License
Server Models” in the Network Licensing Guide, located in the Help
system and on the Documentation link of the Installation wizard.

3. Enter the name of the server that will run the Network License Manager,
or click the Browse button to locate the server. Click Next.



Select the License Type

Stand-alone license

@) Metwork license

Select the license server model you will use with the Network License Manager:

Single License Server -

Enter the name of the server that will run the Metwark License Manager.,

MLMSVR.1 Browse...

To deploy a network license using a distributed license server model

1. While creating a deployment, on the Select the License Type page, select
the Network License option.

2. Select Distributed License Server as the license server model you want
to use with the Network License Manager.

If you have already used the Network License Manager to create a
license server model, you must select the same license server model in
this step. If you have not yet used the Network License Manager to
create a license server model, make sure that you select the same settings
in the Network License Manager that you choose here.

For detailed information about license server models, see “License
Server Models” in the Network Licensing Guide, located in the Help
system and on the Documentation link of the Installation wizard.

3. Enter the name of one of the servers that will run the Network License
Manager, or click the Browse button to locate the server. Click Add to
add the server to the Server Pool. Once all the servers are added to the
Server Pool list, use the Move Up and Move Down buttons to arrange
the servers in the order you want them to be searched by a user's
workstation. You must enter at least two servers. Click Next.



Select the License Type

(") Stand-alone license

@ Metwork license

Select the license server model you will use with the Network License Manager:

Distributed License Server -

Enter the name of ane of the servers that will run the Network License Manager
utility, and then dick Add to add the server to the server poal. Continue adding
gerver names until all the distributed license servers are listed.

Server name:

MLMSVR.3 Browse... Add

Server pool:

To deploy a network license using a redundant license server model

1. While creating a deployment, on the Select the License Type page, select
the Network License option.

2. Select Redundant License Server as the license server model you want to
use with the Network License Manager.

If you have already used the Network License Manager to create a
license server model, you must select the same license server model in
this step. If you have not yet used the Network License Manager to
create a license server model, make sure that you select the same settings
in the Network License Manager that you choose here.

For detailed information about license server models, see “License
Server Models” in the Network Licensing Guide, located in the Help
system and on the Documentation link of the Installation wizard.

3. In the First Server Name field, enter a server name of one server that will
run the Network License Manager, or click the Browse button to locate
the server. Enter the server names for the remaining two servers that you
will use in the redundant server pool. Click Next.



Select the License Type

(") Stand-alone license

(@ Metwork license

Select the license server model you will use with the Network License Manager:

Redundant License Server -

Enter the name of the three servers that will form the redundant
server pool.

First server name:

MLMSVR.1 Browse. ..

Second server name:

MLMSVR.2 Browse...

Third server name:

il

MNLMSWVR.3 Browse...

Note If you are not sure how to obtain the server host name, see “Plan
Your License Server Configuration” in the Network Licensing Guide.
The Network Licensing Guide is located in the Help system and on the
Documentation link of the Installation wizard.
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elect the Installation Type (optional)

As part of making your deployment choices, you select the type of installation
that users receive when they install the program, choose which optional tools or
features are included, and specify where the product is installed on each
workstation.

Select the Installation Type
@ Typical

() Custom

Install optional tools:

Express Tools

[] Material Library

Product install path:

C:\Program Files\<MyProduct=}, Browse...

Disk space requirements;

Volume Disk Size  Available  Required Total Required  Remaining

C: = = amME 955 ME

= Typical. Installs the most common application features. This option is
recommended for most users.

= Custom. Installs only the application features that you select.

You can also choose to include Express Tools and the Material Library with this
deployment.



»  Express Tools. Express Tools are available in their original form, in
English only, and are not supported. No updates have been made to the
tools. Double-byte characters are not supported.

Note Some Express Tools have been integrated into AutoCAD Land
Desktop 2009. For a full list of tools that have been integrated, see the
FAQ section in the Express Tools Help. You can also get help on each
integrated command in the product Help system.

»  Material Library. The Material Library contains more than 300
materials that you can apply to your models. The library is organized as
a series of tool palettes.

You choose the location where program files are installed on the client
workstation in the Product Install Path. To help decide where the product is
installed, a chart of drives and disk space is provided.

To deploy a typical installation, choose optional tools and specify a product
location

1. During the deployment, on the Select the Installation Type page, select
Typical as the type of installation that you want.

Select the Installation Type
@ Typical
Custom
Install optional tools:
[¥] Express Tools

| Material Library

Product install path:

C:\Program Files\<MyProduct=}, Browse...

Disk space requirements;

Volume Disk Size  Available  Required Total Required  Remaining

C: = = amME 955 ME




2. Clear the check box for the Express Tools option if you do not want to
include the tools in this deployment. Express Tools are installed by
default.

3. If you want to install the Material Library, select the check box for the
Material Library option. The Material library option is cleared by
default.

4. Enter the path on the client workstation where you want to install the
program, for example C:\Program Files\AutoCAD Land Desktop 2009,
or click the Browse button to specify the install location.

The Disk Space Requirements chart lets you review available drives and
disk space.

5. Click Next.

To deploy a custom installation, choose optional tools and specify a
product location

1. During the deployment, on the Select the Installation Type page, select
the Custom option as the type of installation that you want.

Select the Installation Type

() Typical
@ Custom

Select features to install;

Feature description:

=) [ ‘5 Feature

..... 7 A CAD Standards

..... 7| 4, Database

..... 7] 4, Dictionaries

..... < 4k Drawing Encryption

..... 7 Ak Express Tools

..... 7 \"L Fonts

..... 4 Ak Autodesk Impression Toolbar

m

Contains all selectable features.

Restore Defaults |

Product install path:
C:\Program Files\<MyProduct=},

Disk space reguirements;

Browse...

C:

Yolume Disk Size  Available  Required

M ME

Total Required  Remaining
955 MB




2. From the Select Features to Install list, select the features that you want
to install.

Your choices are as follows:

CAD Standards

Contains tools for
reviewing design
files for compliance
with your standards.

Database Contains database
access tools.
Dictionaries Contains multi-

language
dictionaries.

Drawing Encryption

Allows you to use
the Security Options
dialog box to
protect a drawing
with a password.

Express Tools

Contains AutoCAD
Land Desktop
support tools and
utilities (not
supported by
Autodesk).

Fonts

Contains AutoCAD
fonts and True Type
fonts.

Material Library

The Material library
contains over 300
professionally built
materials to apply to
your model.




New Features Workshop Contains animated
demos, exercises,
and sample files to
help users learn the
new features.

Migrate Custom Settings Migrates custom
settings and files
from a previous
version of your
product to this
version.

Reference Manager Allows users to
view and edit the
paths of externally
referenced files
associated with a
drawing.

Samples Contains various
feature sample files.

Tutorials Contains tutorials.

Note Autodesk Impression availability is limited. Please check your local
Autodesk website to see if Impression is available in your country.

If, after making feature changes, you decide you want the original
selections, click the Restore Defaults button.

3. Enter the path on the client workstation where you want to install the
program, for example, C:\Program Files\AutoCAD Land Desktop 2009,
or click Browse to specify the install location.

The Disk Space Requirements chart lets you review available drives and
disk space.

4. Click Next.
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lefine Search Paths and File Locations (optional)

On the Define Search Paths and File Locations page, you can modify the default
search paths and the location of some program files. You might want to modify
the default settings for the following reasons:

m If your CAD environment uses a file (such as a customization file or
plug-ins) other than the default file that's installed with the program, you
can point to that file now and avoid having to add it at each workstation.

m  Some default file locations may have changed in this version of the
program. You can use this page if you have an earlier version of the
program, and you want to move the files to the same file location as your
earlier version of the program.

Note You can also modify the search paths and file locations for individual
workstations after you have installed the program. You do this by using the
Options dialog box. For more information, see Specify Search Paths and File
Locations in the User's Guide.

To use the default program settings for search paths and file locations

m  While creating a deployment, on the Define Search Paths and File
Locations page, click Next.

To modify the default program settings for search paths and file locations

1. While creating a deployment, on the Define Search Paths and File
Locations page, in the Define Search Paths, File Names, and File
Locations list, click the plus sign (+) to the left of a search path or file
location to select and expand it.


javascript:hhctrl_d0e1886.Click()

Define Search Paths and File Locations

Define search paths, file names and file locations:
% Suppaort File Search Path = Browse. ..
E Customization Files

Custom Dictionary File ‘

Alternate Font File r ‘ Emove

Font Mapping File
E Printer Suppart File Path £
% Automatic Save File Location Mowe Down
% Color Book Locations
% Data Sources Location
E Template Settings

i o n

2. Select an item in the list and do any of the following:
m To browse to a file location, click Browse.

m To add a new entry to the currently selected search path or file
location, click Add.

m To remove an entry from the currently selected search path or file
location, click Remove.

» To move a selection up or down in the list, click Move Up or
Move Down.
Note The availability of these buttons depends on the item that you
selected in the previous step.

3. When you finish specifying search paths or file locations, click Next.
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1stall Additional Files (optional)

On the Install Additional Files page, when you click Browse, you can specify
additional files to include with a deployment. By default, these files are installed
in the program's installation directory on client workstations when the
deployment is run. You can install files to multiple directories if desired.

You can perform the following operations:

= Specify additional files (such as drawing files, AutoLISP® routines, or
script files) to include with your deployment.

» Install different types of files to different workstation directories.

m  Add subfolders under the installation folder (for example, a folder called
LSP to contain custom AutoLISP routines).

m  Add files to the same location as program files (for example, add sample
drawings for a project).

m  Add files to the root of the installation directory.

Note It is recommended that you install these files to a location within the
program's directory structure. You cannot install files with the same file name as
an installed program file. For example, you cannot add a file named acad.cui.

To install additional files

1. While creating a deployment, on the Install Additional Files page, set the
location where file will get installed.



Install Additional Files

To indude additional files into this deployment, first set the location of where the
file(s) will be installed, then dick Browse to select the file(s) to be induded.

Spedify where to place the files:

=111 [ [F]

=
E H
- | Express
- Fonts Add Folder
-} GAC430
- GAC431 Add Drive
- 0y GAC432
- | GAC433 R
- | GAC434
- 4y GAC435

»

i

Browse...
| CER
, Drv

m

1. Help

- |, Sample
- |, Support
- 1. Tutorial -

2. Do any of the following:

m Click Browse to open the Add Files dialog box, where you can

select files to add to the installation directory.

Click Add Folder to create a new folder in the installation
directory.

Click Add Drive to add a drive name to the file location structure.
The drive name must be a valid drive letter and colon, for
example C: or F:. Uniform Naming Convention (UNC) paths are
not supported.

Click Remove to delete a file, folder, or drive from the
installation directory.

3. Click Next.

Please send us your comment about this page
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utoCAD Land Desktop 2009 Network Administrator's Guide > Deploy the
'ogram > Use the Installation Wizard to Set Up a Deployment >

pecify User Preferences (optional)

On the Specify User Preferences page, you can specify whether installations
based on this deployment can proceed if Microsoft Internet Explorer is not
installed, specify a default profile name, choose to display the product shortcut
icon on the desktop, or create a custom desktop shortcut.

To specify user preferences settings

1. While creating a deployment, on the Specify User Preferences page,
clear the check box for the Internet Explorer option if you do not require
Microsoft Internet Explorer to be installed before AutoCAD Land
Desktop is installed.

Specify User Preferences

Yes, T wish For Inkernet Explorer to be required For installations
Set the default profile name:

< <Unnamed Profile ==

Zhoose a default text editor:

3 Motepad V

2. In the Default Profile Name box, specify a default profile name that will
be current for all users who run the deployment and the default text
editor.

3. Clear the check box for Create an AutoCAD Land Desktop 2009
Desktop Shortcut if you do not want the product shortcut icon to appear
on the user's desktop.

4. If you want to create a custom desktop shortcut, specify a shortcut name



and any parameters, such as switches that will call profiles, startup
scripts, and so on.

Create custom desktop shortouts:

Shortcut name Shorcut parameters
<type shorcut name= <type parameter=

5. Click Next.

Please send us your comment about this page
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1clude Service Packs (optional)

During the deployment process, you can choose to include service packs that
have been posted for your product. The installer automatically checks
autodesk.com for available updates. If updates are available, a link is displayed
(Updates are available). If no updates are available, the link is not displayed.

Include Service Packs

If service packs are available for vour product, you may download them from Autodesk and
indude them with the product's deployment.

Updates are avallable

To indude service packs, you must extract and save the M5F file. Then, you must browse to
locate the MSP file(s) and add them to the list below.

Service packs induded in this deployment:

Browse...

=
i
o
m

Service pack options:

(@ Append the service packs onto the deployment.
(") Merge the service packs into the administrative image MSI file,

When you include a service pack, you can also specify how it will be handled.
You can choose from the following;

= Append the Service Packs onto the Deployment. When you append a
service pack, the service pack is applied to the current deployment only.
Multiple service packs may be appended to a deployment. The service
pack file is included in the deployment and the service pack is applied
after the product is deployed.



Merge the Service Packs into the Administrative Image MSI File.
When you merge a service pack, the service pack is merged into the
administrative image. Once merged, a service pack may not be removed
from the administrative image. Multiple service packs may be included
in a single administrative image.

To extract an MSP file from a service pack

1.
2.
3.

Download the service pack from the Autodesk product support site.
Review the service pack Readme file for information about patch usage.

Open a Windows command prompt and enter the patch file name
followed by the /e switch and a target file name, such as:

ProductSP1.exe /e ./ProductSP1.msp

where <ProductSP1.exe> is the name of the downloaded patch and
<ProductSP1.msp> is the name of the extracted file. Using ./’ in front of
the extraction file name places the extracted file in the same folder as the
original executable.

Note To find out if a service pack is available, visit the Autodesk Product
Support page at http://support.autodesk.com.

To include a service pack with the deployment

To include a service pack with a deployment, an MSP file must be extracted
from the downloaded service pack executable.

1.
2.

On the Include Service Packs page, click the Browse button.

In the Open dialog box, locate the service pack you want to include with
the deployment.

Select the MSP file and click Open.

Specify whether you want to append the service pack on to the
deployment or merge the service pack into the administrative image.

Click Next.

Please send us your comment about this page
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utoCAD Land Desktop 2009 Network Administrator's Guide > Deploy the
'ogram > Use the Installation Wizard to Set Up a Deployment >

onfigure InfoCenter Communication Center (optional)

The Communications Center is accessed through InfoCenter. Products are
updated with Live Update, which downloads patches to your product using
Communication Center. Beyond Live Update, other information channels and
feeds can be displayed by the Communication Center.

Configure InfoCenter Communication Center

Communication Center Panel
Enable live updates
[F‘.eceive Live Updates from Autodesk -

m
[=]

Enable Information Channels

Enable CAD Manager Channel

Feed location:

Vserverifeed\myfeed. xml Browse...

Display name:

CAD Manager Channel

Enable RS5 feeds
[] allow user to add RSS feeds

The Communication Center settings you can make include

=  Enable Live Updates. Users can use Live Update to check for updates
when a web connection is established. If a product patch is available,
notification of its availability is received on the program's status bar, and
the patch can be either downloaded directly from an Autodesk server or
modified first before being copied to users' workstations. If you don't



want users to receive updates or announcements, you can turn off Live
Update.

Note You can also turn Live Update options on or off in the CAD

Manager Control utility. See How to Install and Start the CAD Manager
Control Utility

= Enable Information Channels. When active, information channels
notify users with various pieces of information such as subscription
announcements and product support information.

=  Enable CAD Manager Channel. Controls the display of the CAD
Manager Channels in InfoCenter. Aside from being able to toggle CAD
Manager Channels, you can also define the CAD Manager feed location
and set the display name for the CAD Manager Channel.

=  Enable RSS Feeds. Users can subscribe to any number of RSS feeds.
Each feed is contained within a discrete InfoCenter category.
Additionally, you can specify whether users can add RSS feeds.

To configure Communication Center

1. When creating a deployment, on the Configure InfoCenter
Communication Center page, make the following Live Update settings:

= Enable Live Updates. Users can receive product updates or
support announcements from Autodesk servers.

= Receive Live Updates from Autodesk. Users can receive
product updates and support announcements from Autodesk
servers with Live Update.

= Receive Live Updates from Internal Server. You can maintain a
patch list on a local server. If you select this option, the Local
Patch List Location box is available. Use the Browse button to
locate the path to a server location where you want a patch list.
More information about how to use a local patch list is available
by installing Autodesk CAD Manager Tools 4.0, running the
CAD Manager Control utility, and then clicking Help in the CAD
Manager Control utility window.

Note You can name a file to use for patch information. By naming
a file and using an .npl extension now, you are creating a
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placeholder file, not creating the file itself. In the location that
you specify in the Local Patch List Location box, you must create
a text file with the same name you specify here.

. Specify whether Information channels should be enabled.

. Specify whether CAD Manager channels should be enabled. When
active, you can make the following settings:

» Feed Location. Defines the location of the CAD Manager
channel RSS feed. RSS feeds are in XML format.

= Display Name. Sets the display name of the CAD Manager
channel.

. Specify whether RSS Feeds are enabled and if users are allowed to add
feeds.

. Click Next.

Please send us your comment about this page
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utoCAD Land Desktop 2009 Network Administrator's Guide > Deploy the
'ogram > Use the Installation Wizard to Set Up a Deployment >

llow Users to Access Online Resources (optional)

On the Configure Access to Online Resources pages, you can specify whether
users can access online resources such as receiving live updates from Autodesk,
enabling information or CAD Manger channels, or subscribing to RSS feeds.
You can also allow access to the DesignCenter and Subscription Center, specify
Customer Error Reporting and InfoCenter settings.

Configure Access to Online Resources

Specify the ability to access onling tools;

Enable DesignCenter{DiC) Online

Allovy access bo Subscripkion Center From within the Autodesk product
{recommended)

Specify the Cuskomer Error Reporting (CER) settings:

Allow users to receive notifications of resolution

|:| Include computer name in error reporks

Specify the Cusktomer Involvement Program settings:

Allow users to choose ko participate in the Customer Involvement
Programirecommended)

DesignCenter and Subscription Center

The DC Online tab in DesignCenter® provides access to predrawn content such
as blocks, symbol libraries, manufacturers' content, and online catalogs. This
content can be used in common design applications to assist users in creating



drawings. If you turn off DC Online, the DC Online tab is removed from all
installations that are based on this deployment. The Enable DC Online option is
active by default.

Subscription Center provides Autodesk subscription members access to
resources such as e-Learning (self-paced, interactive lessons) and web support
(where customers can submit technical questions online to Autodesk support
staff).

Specify the ability to access online tools:

| Enable DesignCenter(DC) Online

Allow access to Subscription Center fram within the Autodesk product
== (recommended)

You can determine whether users who are entitled to subscription resources can
access them by using Help and clicking a Subscription resource. Users who do
not have such access can still learn about subscription resources by using the
same option on the Help menu.

Note You can also enable or disable DesignCenter Online and Subscription
Center access from the CAD Manager Control utility.

Customer Error Reporting (CER)

If AutoCAD Land Desktop closes unexpectedly, users have the opportunity to
send an error report directly to Autodesk, which helps Autodesk to determine
and resolve the error. You can determine whether users can also receive
notification from Autodesk when their reported errors are resolved.

Specify the Customer Error Reporting (CER) settings:

| Allow users to receive notifications of resolution

| Indude computer name in error reports

Note You can also turn Customer Error Reporting notification on or off in the
CAD Manager Control utility.

Configure InfoCenter Search Settings

The Search Results tab of InfoCenter can be configured to display content from



various sources, such as the product Help system, CAD Manager Channels, or
the Internet.

Spedify the InfoCenter search settings:

W | Allowe user to customize search locations

You can specify whether users who install from the deployment can customize
access to their InfoCenter search locations.

To configure access to online resources

1. While creating a deployment, on the Configure Access to Online
Resources page, do one of the following to configure DesignCenter
Online:

m To disable DesignCenter Online, make sure that the check box
next to Enable DC Online is cleared.

» To enable DesignCenter Online, select the check box next to
Enable DC Online.

2. To allow access to the Subscription Center, select or clear the check box
next to Allow Access to Subscription Center from Within the Autodesk
Product (Recommended). This option is enabled by default.

3. If you want to receive notification of problem resolutions, do the
following:

m Select the check box next to Allow Users to Receive Notification
of Resolution so that users are made aware of resolutions to
issues and can download applicable updates provided by
Autodesk. This option is enabled by default.

Note Users must have administrative permissions to install an
update provided by Autodesk.

m Select the check box next to Include Computer Name to include
the user’s computer name in error reports. The computer name is
included in notifications to the user and in reports available to
subscription administrators. This option is disabled by default.

4. Lastly, specify whether users have the option to customize their



InfoCenter search locations. This option is enabled by default.

5. Click Configuration Complete.

Please send us your comment about this page
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inal Review and Complete Setup

To complete your deployment setup, confirm the settings you selected.

To confirm and complete the setup of a network deployment

1. After making all your deployment settings, on the Review - Configure -
Create Deployments page, scroll the list of current settings and verify

your installation selections.

Review - Configure - Create Deployments

The basic information required ko install the products has been provided by wou and is shown in

the box below, The remaining configurations are currently set to the defaulk values; also

shown below, IF wou would like to make configuration changes, select the appropriate product

from the drop down list and click the Configure button,

Select a produck to configure:

! <MyProduck = -[V] Configure

Current settings:

Licensze type: Metwaork License IAJ'
Licensze server model: Single Server License
Server namels) et arkServer
Install type: Typical

Express Toolz Yes

haterial Library Mo !
Install location: CProgram Files\hyPrograrmi,
Search pathzifile locations:
Additional files included: L
Default text editar: Fotepad F
Silent installation: Yes
Internet Explorer is required: Yes
Default profile: ==lnnamed Profile==
Create a shartout: Yes
Cusztom shortouts: ]

[ae]

Service packs applied:

Prink



2. If you want to change any selections you made for the deployment, click

the Configure button.

3. If you want a hardcopy of the installation information displayed on this

page, click the Print button.

4. If you are ready to complete the deployment, click Create Deployment.

5. On the Deployment Complete page, click Finish.

To confirm and complete the setup of a multi-seat stand-alone deployment

1. After making all your deployment settings, on the Review - Configure -
Create Deployments page, scroll the list of current settings and verify

your installation selections.

Review - Configure - Create Deployments

The basic information required ko install the products has been provided by wou and is shown in
the box below, The remaining configurations are currently set to the defaulk values; also
shown below, IF wou would like to make configuration changes, select the appropriate product
from the drop down list and click the Configure button,

Select a produck to configure:

<MyProduck =

Current settings:

[ Configure

Licensze type: Metwaork License ]
Licensze server model: Single Server License
Server namels) et arkServer
Install type: Typical
Express Toolz Yes
haterial Library Mo
Install location: CProgram Files\hyPrograrmi,
Search pathzifile locations:
Additional files included:
Default text editor: Motepad
Silent installation: Yes
Internet Explorer is required: Yes
Default profile: ==lnnamed Profile==
Create a shartout: Yes
Cusztom shortouts:

Service packs applied:

Prink

2. If you want to change any selections you made for the deployment, click

the Configure button.

3. If you want a hardcopy of the installation information displayed on this



page, click the Print button.
4. If you are ready to complete the deployment, click Create Deployment.

5. On the Deployment Complete page, click Register Products Online.

Register all products. Use the link below to register the products online. If you do not have
Internet access you may register the products during the activation process.

Register products onling

Click Finish to exit.

Registration at this stage ensures that consistent data is being used to
streamline product activation. When a user installs from this deployment
and runs the product, registration data is automatically referenced and
the product gets activated. See Register the Product.

6. Click Finish.

You have created an Autodesk product deployment with precise options that are
specific to your group of users. You can now inform those using this deployment
where the administrative image is located so that they can install the program.

Please send us your comment about this page
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egister the Product

It is very important that the registration data (for example, your company name
and contact information) you supply when registering and activating your
products is consistent across all Autodesk products that you install. If you enter
this data incorrectly or inconsistently, you can run into activation problems.

The way products are registered depends upon the type of license you selected
while creating the deployment. In order to receive an activation code, your
product must be registered.

To register a network licensed deployment

1. On the Start menu (Windows), click All Programs (or Programs) »
Autodesk » Network License Manager » AutoCAD Land Desktop 2009
Network License Activation Utility.

2. On the Obtain a Network License page, review how this utility works
and the requirements for using it, and then click Next.

3. Follow the on-screen instructions to complete the registration and
activation.

To register a multi-seat stand-alone licensed deployment

1. On the Deployment Complete page, click Register Products Online.



Register all products. Use the link below to register the products online. If you do not have
Internet access you may register the products during the activation process.

Register products onling

Click Finish to exit.

The Register Today page is displayed. You complete Register Today at
this point so that all users have the same default registration information.

2. In the Register Today wizard, follow the on-screen instructions to
complete the registration.

Note This process only registers the product. If users are connected to the
Internet, activation occurs automatically when the product is started.

Please send us your comment about this page
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Todify a Deployment (optional)

After a deployment is created, it may be necessary to modify the deployment for
some client workstations. You can apply a patch or select various custom files
that are not part of the base administrative image. You can also perform
modifications such as changing the installation directory from drive C to drive
D.

To modify a deployment

1. Open the shared network folder where you originally chose to place your
product deployment.

2. In the Tools folder, double-click the Create & Modify a Deployment
shortcut.

This re-opens the Installation wizard.
3. Click through the deployment pages and make the necessary changes.

4. After all the modifications have been made, click Create Deployment.

Please send us your comment about this page
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oint Users to the Administrative Image

When you have completed the deployment process, you are ready to have users
install the newly created or modified deployment. You need to notify your users
of the shortcut that was created in the administrative image. The shortcut is the
same name that you chose in Create a Deployment.

To point users to the administrative image

m  The simplest method of notifying users how to install the deployment is
to email them with instructions about using the shortcut. At a minimum,
the instructions need to include the location of the deployment and
instructions about double-clicking the shortcut to the deployment.

Note For more advanced ways of using the shortcut and installing the
deployment, see Use Scripts to Deploy the Program, Use Group Policies to
Install a Deployment, or Use Microsoft System Center Configuration Manager
to Install a Deployment.

Please send us your comment about this page
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minstall the Program

When you uninstall AutoCAD Land Desktop 2009, all components are removed
in the process. This means that even if you have previously added or removed
components, or if you have reinstalled or repaired the program, uninstalling
removes all program installation files from your system.

Note Autodesk products that are add-ons to AutoCAD Land Desktop, such as
Autodesk Design Review or Autodesk Vault are not uninstalled when you
uninstall AutoCAD Land Desktop. To uninstall these applications, you must use
the Windows Add or Remove Programs utility.

Note If you plan to modify an administrative image later (for example, by adding
a patch to it), do not remove that image.

To uninstall the program

1. In the Windows Control Panel, click Add or Remove Programs.

2. In the Add/Remove Programs window, select AutoCAD Land Desktop
2009, and then click Change/Remove.

3. When the Installation wizard opens, choose Uninstall AutoCAD Land
Desktop 20009.

4. On the Uninstall AutoCAD Land Desktop 2009 page, click Next to
remove AutoCAD Land Desktop from the system.

5. When informed that the product has been successfully uninstalled, click
Finish.

Please send us your comment about this page
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dvertise a Deployment Using MSI

Advertising is a deployment method that you use to provide access to a
centralized program from a workstation. You create an administrative image in a
central location and then set up each workstation to have a shortcut to the
program. When you click the shortcut, the program is installed on the
workstation.

In order for AutoCAD Land Desktop to run properly, the following software
must be installed on the computer where the program is being installed:

m  Microsoft Internet Explorer version 6.0 Service Pack 1 or later
(www.microsoft.com).

m  Microsoft Installer Package (MSI) 3.1
Topics in this section

= Advertise a Deployment

Please send us your comment about this page
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dvertise a Deployment

After you create an administrative image on a shared directory, you can set up a
shortcut to make the program accessible to users. The program name is added to
the Start menu (Windows) and to the Add/Remove Programs list.

To advertise a deployment using MSI 3.1

1. On the user's workstation, on the Start menu (Windows), click All
Programs (or Programs) » Accessories » Command Prompt.

2. At the Windows command prompt, enter the following to set up a
shortcut:

msiexec /jm \\[servername]\[sharename]\AdminImage\ldt.msi /t

This program is now advertised. To install this program on the workstation, the
user clicks a program shortcut in the Start menu (Windows). This method installs
the program on the workstation with minimal prompts for the user.

Please send us your comment about this page
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Installation scripts are most useful for stand-alone installation of programs on
networked computers. Scripts are also useful for installing service packs,
extensions, and object enablers on a network.

In order for AutoCAD Land Desktop to run properly, the following software
must be installed and prerequisites must be met on the computer where the
program is being installed:

= Microsoft Internet Explorer version 6.0 Service Pack 1 or later
(www.microsoft.com).

m  Microsoft Scripting Engine.

The sample scripts in this section are based on Microsoft Scripting
Engine 5.6, which works with both VBScripts and JavaScript. If you
don't have the scripting engine installed, you can download it for free
from the Microsoft website at www.msdn.microsoft.com/scripting.
Sample scripts and Help files are also available there for download.

m  Administrative permissions.

Topics in this section

= Create Scripts That Install Programs
= A Sample Installation Script
m  Use Switches and Flags in Scripts

= Run Scripts
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reate Scripts That Install Programs

You create a script by using a text editor such as Notepad and then saving it in
ASCII format in a file with the file extension .vbs. The script consists of one or
more commands, as well as command switches that specify options, and flags
that modify the options. An installation script also contains path names.

An installation script points to the location of the product's setup.exe file. You
must point to the setup.exe file on your product DVD 1. For example:

AutoCAD Land Desktop 2009 DVDROM1 \setup.exe

Please send us your comment about this page
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. Sample Installation Script

The sample script in this section installs the program in a typical configuration.
To make it easy to copy this sample script and substitute your own information,
the same names are used throughout for variable items. The log file name is
based on the product being installed. You can either use the log file name in the
script or change it to something else.

Serial number prefix: 123

Serial number: 12345678

First name: Your First Name

Last name: Your Last Name
Organization: Your Company Name

A sample script for a silent installation of this program uses the syntax shown in
this section.

Scripted installation for AutoCAD Land Desktop 2009

' Scripted installation for AutoCAD Land Desktop 2009
option explicit

' Create variables

dim x64bit

dim shell

dim productType

dim featuresToInstall
dim strADSKFirstName
dim strADSKLastName

dim strADSKOrganization
dim strADSKSercirity



dim strADSKSerialIsvalid

dim strADSKAccept

dim strADSKEula

dim strADSKReInstall

dim strADSKRemove

dim strADSKSNPrefix

dim strADSKSNNumber

dim strInstalllLevel

dim strACADStandaloneNetworkType
dim strADSKLicenseServerType
dim strADSKLicenseType

dim strADSKServerFmtPath

dim strADSKServerPath

dim strADSKServerHostID

dim strADSKPath

dim strSourcePath

dim strAdditionalStuff

Script initialization
Set shell = CreateObject("WScript.Shell")

productType = "acad"

' Name and Organization information

strADSKFirstName = "Your First Name"
strADSKLastName = "Your Last Name"
strADSKOrganization = "Your Organization Name"

Serial Number information
StrADSKSNPrefix = "123"
StrADSKSNNumber = "4567890601"

' Source to install from (e.g. D: is assumed to be Install Media)
strSourcePath = "D:\"

' Destination to install to

strADSKPath = Shell.ExpandEnvironmentStrings("%ProgramFiles%") + "\
' Features to install

' ACS - AutoCAD Land Desktop Samples

' CADStandards - CAD Standards

' ContentSearch - Content Search

' Database - Database (DBCONNECT)

' DCS - DesignCenter Samples

' DigSig - Digital Signatures

' Dictionaries - Dictionaries



featuresToInstall

DrawingEncryption - Drawing Encryption
Express_Tools - Express Tools

Fonts - Fonts

Impression - Autodesk Impression Toolbar
Materials - Materials Library

Migrate - Migrate Custom Settings

NFW - New Features Workshop

PLM - Portable License Utility

RefMan - Reference Manager

System_Files - Required system files (must be installed by default
T™M - Texture Maps

VBA - Visual Basic for Applications

VLS - Visual LISP Samples

VLT - Visual LISP Tutorials

Sample is below - Note the leading comma

",DigSig, TM, CADStandards, ContentSearch, Database,

strInstallLevel=3 ' 5 installs everything - 3 installs typical - 0 u

"trit o Uncomment the relevant version of your installation - Default

For Standalone

RunStandaloneInstall()

For Single Network License Server

'"RunSinglelLicenseServerInstall()

For Redundant Network License Servers

'"RunRedundantLicenseServerInstall()

For Distributed Network License Servers

'RunDistributedLicenseServerInstall()

End of Script

Wscript.quit()

Function RunStandaloneInstall
shell.run DefaultCommand(),2,1
end function

Function RunSinglelLicenseServerInstall

Update with the correct information for the license server

strACADStandaloneNetworkType = "3"
strADSKLicenseServerType = "Single Server License"
strADSKLicenseType = "Network License"
strADSKServerPath = "myFlexServer"

HOSTID or MAC address



SstrADSKServerHOSTID = "000000000000"
' Consolidate the two values

strADSKServerPath = strADSKServerPath & " " & strADSKServerHOSTID
shell.run MakeCommand(),2,1

end function

Function RunRedundantLicenseServerInstall

' Update with the correct information for the license servers
strACADStandaloneNetworkType = "3"

strADSKLicenseServerType = "Redundant Server License"
strADSKLicenseType = "Network License"

' Format is SERVERNAME1 MACADDR1 PORT1; SERVERNAME2 MACADDR2 PORT2; S
strADSKServerPath = " myflexl 000000000000 27005; myflex2 00O0000000C
shell.run MakeCommand(),2,1

end function

Function RunDistributedLicenseServerInstall

' Update with the correct information for the license servers
strACADStandaloneNetworkType = "3"

strADSKLicenseServerType = "Distributed Server License"
strADSKLicenseType = "Network License"

' Format is @SERVERNAME1; SERVERNAME2; SERVERNAME3;
strADSKServerPath = "@ myFlexServer;@ myFlexServer2;@ myFlexServers3;

shell.run MakeCommand() & "ACAD_LICENSESERVER_DISTRIBUTED=1",2,1
end function

Function DefaultCommand
dim retString
' /q for silent install ' /c [key] override parameters for the key

retString = """" & strSourcePath & "D:\setup.exe" & """" & " /t /q /
retString = retString & "INSTALLDIR=" & """" & strADSKPath & """" &
retString = retString & "ACADSERIALPREFIX=" & strADSKSNPrefix & " "
retString = retString & "ACADSERIALNUMBER=" & strADSKSNNumber & " "
retString = retString & "ACADFIRSTNAME=" & """" & strADSKFirstName &
retString = retString & "ACADLASTNAME=" & """" & strADSKLastName & "
retString = retString & "ACADORGANIZATION=" & """" & strADSKOrganiza
if strInstalllLevel = 0 then

retString = retString & "ADDLOCAL=" & """" & "System_Files" & featur
else

retString = retString & "InstalllLevel=" & strInstalllevel & " "
DefaultCommand = retString & " "
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eploy the Program >

'se Switches and Flags in Scripts

The following table lists all of the switches and flags that are relevant to

installation.

Note You must set the installation switch to INSTALLDIR=. If this is not done,
programs that run outside AutoCAD Land Desktop (such as the Portable License

utility) are not installed.

Switches in Installation Scripts

INSTALLDIR= Specifies the location to
install the product.
ACADSERIALPREFIX= Specifies the numbers that
precede the hyphen in the
serial number.
ACADSERIALNUMBER= Specifies the serial
number.
INSTALLLEVEL= Specifies the type of
installation: 3=Typical
ACADFIRSTNAME= Specifies the first name
personalization.
ACADLASTNAME= Specifies the last name



personalization.

ACADORGANIZATION= Specifies the company
name.
ADDLOCAL-= Used for customized

installations where you
designate specific features
to install.

User Interface Flags

Designates that the installation is performed in silent mode.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

utoCAD Land Desktop 2009 Network Administrator's Guide > Use Scripts to
eploy the Program >

un Scripts

After creating a script, you move it to a server or use a mapped drive letter or a
UNC (universal naming convention) path. If you place it on a server for users to
run, create a share on the server, and then add users to the share with the rights
they need. Because all that users need to do is run the script, provide read-only
access to the share directory.

Next (on the same server or on a different server), create a directory for each
product you want to install. Choose a location for this directory that won't be
changed so that you can point to the MSI files in your scripts. Copy the product
DVDs to that directory. You may also want to create directories for service
packs, extensions, and your own customization tools.

You can use any of the following methods to run an installation script:

m  Run the script manually at each individual workstation. To run the
installation, paste the script into the Run dialog box or run it from the
Windows command prompt.

= Send an email with the UNC path to each user who should run the script.
To run the script, the user follows your instructions.

= Email the script to each user with instructions for use.

= Set up the script so that it runs on login.
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With group policies, you can advertise this program by assigning the deployment
to computers.

In order for AutoCAD Land Desktop to run properly, the following software
must be installed on the computer where the program is being installed:

= Microsoft .NET 3.0 (available on the product DVD)

m  Microsoft Internet Explorer version 6.0 Service Pack 1 or later
(www.microsoft.com).

m  Microsoft Installer Package (MSI) 3.1

m  Microsoft Windows Media Format 9.5 (prerequisite for 64-bit)
m  Macromedia Flash Player 9.0 (not installed by default)

= Autodesk Design Review 2009 (not installed by default)

m  VC runtimes for x86 and x64 for 64-bit deployments
Topics in this section

®  Introduction

= Distribute a Deployment Through Group Policies

= Assign a Deployment to Computers
m  Verify the Installation of a Deployment
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1troduction

With group policy objects, this program can be advertised to any computer that
is part of Windows 2000, Windows XP, and Windows 2003 Server Active
Directory environments.

Topics in this section

= Assign a Deployment Using Group Policies
= Advantages and Disadvantages of Using Group Policies
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ssign a Deployment Using Group Policies

Assign a deployment that was created during the deployment process by the
Installation wizard to a computer. Assigning a deployment to a computer installs
the program the next time the computer is restarted.

A deployment that is assigned to a computer can be used by any user of that
computer. Generally, you should assign the program to a computer if the
computer is used by a large number of users.

Note Autodesk products are designed to be installed on a computer so that any
user who logs on to the computer can run the software. If you attempt to assign
this program for a specific user rather than a computer, you may encounter
problems when a second specified user tries to install or uninstall a copy of the
program.
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dvantages and Disadvantages of Using Group Policies

The following table outlines the advantages and disadvantages of using group
policies.

Advantages and disadvantages of group policies

m  Works well with the m  Cannot pass command-line
deployment functionality parameters to MSI executable.
of the Installation The solution is to use scripts.
wizard.

= FEasy to add custom files m Cannot customize application
through the deployment settings other than what is set
functionality of the while creating a deployment
Installation wizard. with the Installation wizard.

m  Deployed to workstation.

=  Simple to implement.
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There are three main steps to distributing this program through group policies.

1. Create an application distribution share point. The application
distribution share point is created using the Deployment wizard. Follow
the steps outlined in Use the Installation Wizard to Set Up a Deployment
to create a deployment.

2. Assign the program to a computer.

3. Verify the installation. Make sure that the program has been correctly
installed.
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When the program is assigned to a computer, it is available to all users of the
computer. The following procedures must be run from the server that has access
to the Windows 2003 Server, Windows XP, or Windows 2000 Active Directory
for assigning this program to computers.

To assign a deployment to a computer

1.

On the Start menu (Windows), click All Programs (or Programs) »
Administrative Tools » Active Directory Users and Computers.

In the Active Directory Users and Computers window, right-click the
organizational unit where you want to create the group policy object.
Then click Properties.

The Properties dialog box for the organizational unit you selected is
displayed.

Note In order for the group policy object to take effect, the computer
objects must be located in the organizational unit you have selected.

In the Properties dialog box, on the Group Policy tab, click New. Enter a
name for the group policy object. For example, enter AutoCAD Land
Desktop Computer Assigned Installation.

The group policy is created and is added to the Group Policy Object
Links list.

In the Group Policy Object Links list, click the policy you just created,
and then click Edit.

Do one of the following:

= For Windows 2003 Active Directory: In the Group Policy



Object Editor window, under Computer Configuration, click the
plus sign (+) next to the Software Settings folder to expand it.

= For Windows 2000 Active Directory: In the Group Policy
window, under Computer Configuration, click the plus sign (+)
next to the Software Settings folder to expand it.

6. Under Software Settings, right-click Software Installation, and then click
Properties.

7. In the Software Installation Properties dialog box, on the General tab,
click Browse.

8. In the Browse for Folder dialog box, locate the application distribution
share point created in the Deployment wizard, and select the
AdminImage folder. Then click OK.

The Software Installation Properties dialog box displays (in UNC
format) the default package location, the server name, the shared folder
that you selected, and AdminImage. For example:

\\server123\Deployment\Adminlmage\x86 or x64 depending on the
process type

9. Do one of the following:

= For Windows 2003 Active Directory: On the General tab, under
New Packages, click Advanced to specify a method to be used
when a new package is created. This method also allows the
transform file created by the Deployment wizard to be selected.

= For Windows 2000 Active Directory: On the General tab, under
New Packages, click Advanced Published or Assigned to specify
a method to be used when a new package is created. This method
also allows the transform file created by the Deployment wizard
to be selected.

10. Click OK to close the Software Installation Properties dialog box.
11. Do one of the following:

= For Windows 2003 Active Directory: In the Group Policy
Object Editor dialog box, under Software Settings, right-click
Software Installation, and click New » Package.



12.

13.

14.
15.

16.

17.

= For Windows 2000 Active Directory: In the Group Policy
dialog box, under Software Settings, right-click Software
Installation, and click New » Package.

In the Open dialog box, make sure the Windows Installer Packages file
(Idt.msi) is selected, and click Open. This default selection is the
application distribution share point that you set earlier.

If you created the administrative image in a location different from the
application distribution share point, find the administrative image
location, and click 1dt.msi.

In the <product name> Properties dialog box, click the Deployment tab.
Under Deployment Type, verify that Assigned is selected.

On the Modifications tab, click Add.

In the Open dialog box, click the transform package file (.mst) created
by the Deployment wizard, and then click Open.

If you created the administrative image in a location different from the
application distribution share point, find the administrative image
location and select the transform package file (.mst).

In the <product name> Properties dialog box, on the Modifications tab,
the transform package you selected is added to the Modifications list.
Click OK.

Note You must select the transform package file created by the
Deployment wizard when you created the group policy object. You
cannot add or remove transform package files after the group policy
object has been created. If you fail to select a transform package file, the
program cannot be installed on the client computer.

Do one of the following:

= For Windows 2003 Active Directory: In the Group Policy
Object Editor window, under Computer Configuration, click
Software Installation. The newly created program package is
displayed in the right pane.

= For Windows 2000 Active Directory: In the Group Policy
window, under Computer Configuration, click Software
Installation. The newly created program package is displayed in



the right pane.
18. Do one of the following:

= For Windows 2003 Active Directory: Close the Group Policy
Object Editor window and any other open Active Directory
windows.

= For Windows 2000 Active Directory: Close the Group Policy
window and any other open Active Directory windows.

This program is assigned to all computers that are members of the organizational
unit for which the group policy object has been created. The next time a
computer in the organizational unit is restarted, the program will be installed and
will be available for all users of the computer. See Verify the Installation of a
Deployment to validate that the group policy has been created correctly.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

utoCAD Land Desktop 2009 Network Administrator's Guide > Use Group Policie
Install a Deployment >

erify the Installation of a Deployment

As a computer is restarted, the operating system displays messages about group
policy, generally just before or after the Windows Login dialog box is displayed.
These messages include the following:

m  Windows starting up

= Applying computer settings

m Installing managed software <application>
= Applying software installation settings

» Loading your personal settings

= Applying your personal settings

From a Windows XP or Windows 2000 workstation, users log in under the
organizational unit or computer for which the group policy has been created.

Note If problems arise, an entry is logged in the system's Event Viewer under
Applications.

Topics in this section

= Verify That the Program Is Assigned to a Computer
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erify That the Program Is Assigned to a Computer

To verify that this program has been correctly assigned to a computer, restart a
computer that is in the organizational unit for which the group policy was
created. The program is installed before the login prompt is displayed. After
logging in, double-click the program icon on the desktop. A second-time
installation begins. At the completion of the installation, the program starts.
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This appendix provides details for deploying Autodesk software using Microsoft
System Center Configuration Manager (SCCM). SCCM allows you to manage
software distribution to selected target systems through a remote process.

Topics in this section

®  Introduction

m Tasks for Deploying Autodesk Software with SCCM

= Set Up a Source Directory Using the Deployment Wizard
= Create the SCCM Software Installation Package
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1troduction

To deploy Autodesk software, you should be familiar with the SCCM/SMS
software distribution process. For more information about this topic, consult
your Microsoft SCCM documentation and support resources.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

utoCAD Land Desktop 2009 Network Administrator's Guide > Use Microsoft
sstem Center Configuration Manager to Install a Deployment >

asks for Deploying Autodesk Software with SCCM

To deploy Autodesk software with SCCM, it is recommended that you complete
the following:

Identify or create a collection of target systems to receive the software
package

Create a source directory using the Deployment wizard
Create a SCCM package to deploy to your target systems
Provide the path for the source files

Distribute the SCCM package to the distribution points

Create an advertisement to notify users of the availability of the software
package
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et Up a Source Directory Using the Deployment Wizard

When you use SCCM to deploy Autodesk software, you set up the source
directory using the Deployment wizard.

The Deployment wizard creates an administrative image that is used by SCCM
to distribute the Autodesk software to the target systems. The location where you
perform the administrative installation becomes the location of the package
source directory.

To learn more about deployments and setting up the source directory for
Autodesk software, see the following topics in the Network Administrator’s
Guide:

m  Preliminary Tasks for a Network Deployment

m  (Create a Deployment

m  Use the Installation Wizard to Set Up a Deployment

m  Modify a Deployment (optional)

Note It is recommended that you test the deployment created by the Deployment
wizard before trying to configure SCCM to deploy the program to ensure that
there are no problems with the administrative image and deployment.

To test the Deployment wizard deployment

1. Log on to a Windows XP Professional or Vista workstation as a user
who has administrative privileges.

2. Navigate to the source directory where your deployment was created.

3. Double-click the deployment shortcut created by the Deployment
wizard.



The program will either be installed or error information will be written
to the log file at %temp%.
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reate the SCCM Software Installation Package

After creating the source directory using the Deployment wizard, you create the
SCCM software installation package. An SCCM package contains the files and
instructions that SCCM uses to distribute the software and advertise the package.
The Deployment wizard creates the files and instructions, but SCCM must be
configured to use these files.

To create a software installation package using SCCM

1.

On the Start menu (Windows), select All Programs (or Programs) »
Microsoft System Center» Configuration Manager 2007 » ConfigMgr
Console.

In the Configuration Manager Console window, expand Software
Distribution.

Right-click Packages » Distribute » Software.
In the Distribute Software Wizard, click Next.

In the Package dialog box, select Create a new package and program
without a definition file. Click Next.

In the Package Identification dialog box, enter the information for Name,
Version, Publisher, Language and any comments. Click Next.

The Source Files dialog defines where SCCM retrieves the files and how
it manages them. After making your choice, click Next.

Note In this procedure, “Always obtain files from a source directory” was
chosen.

In the Source Directory dialog box, specify the directory where the
source files are stored. The source directory should end with



10.

11.

12.

13.

14.

15.

16.

AdminImage as the last folder in the source directory name. Click Next.

In the Distribution Points dialog box, select the distribution point(s).
This is the location from which the software package will be deployed to
the target systems. Click Next.

In the Program Identification dialog box, enter the name of your
program. This is the name that displays in Add or Remove Programs in
the Control Panel. In the Command Line field, enter setup.exe/i
<deployment name>.ini. Click Next.

In the Program Properties dialog box, Program Can Run drop-down box,
select how you want your program to install. Your choices are:

= Only when a user is logged on
m Whether or not a user is logged on
= Only when no user is logged on

In the After Running drop-down box, select an action to take after the
program has deployed. Your choices are:

m No action required
m Program restarts computer
m ConfigMgr restarts computer

m ConfigMgr logs user off
Note AutoCAD 2009 requires you to restart your system after installation.

Click Next.

In the Advertise Program dialog box, choose Yes to Advertise the
program. Click Next.

In the Select a Program to Advertise dialog box, select the package you
want to advertise. Click Next.

In the Select Program » Advertisement Target dialog box, choose the
collection to which you want to advertise, or create a new collection.

In the Select Program » Advertisement Name dialog box, enter or
change the name of your advertisement. Add any comments to further



17.

18.
19.

20.

21.

describe the advertisement. Click Next.

In the Select Program » Advertisement Subcollection dialog box, select
one of the following options:

m Advertise this program to an existing collection
m Create a new collection and advertise this program to it

Click Next.

In the Select Program » Advertisement Schedule dialog box, if desired,
set options to advertise your program at a specific date and time, or set
an expiration date. Click Next.

In the Select Program » Assign Program dialog box, select one of the
following options:

m If the installation process is mandatory, select “Yes, assign the
program”

m [f the installation process is optional, select “No, do not assign the
program”
Click Next.

In the Summary dialog box, verify your advertisement information. Use
the back buttons to make any changes. To finish, click Next.
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The following information is provided for those who use imaging software, such
as Norton Ghost, to create a master image to distribute Autodesk products. Once
created, the master image is then replicated to other computers throughout your
facility.

Exersise caution, since the use of imaging software can result in:
= Conflicts with the product licensing.
m  Incomplete installations and problems with activation.

Note If you are experiencing licensing instability in a SATA RAID environment,
using imaging software to distribute Autodesk products can cause product
activation problems, such as “Activation code limit exceeded” when you attempt
to activate.

Topics in this section

m  Use a Master Image to Distribute Multi-Seat Stand-Alone Products
to Multiple Systems

m  Use a Master Image to Distribute Network Licensed Products to
Multiple Systems

=  Restore the Master Image

=  Clean a Master System and Restore the Operating System
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'se a Master Image to Distribute Multi-Seat Stand-Alone
roducts to Multiple Systems

You can distribute the product using a master image for a multi-seat stand-alone
product.

Note When using Norton Ghost, you must use the -ib switch to include the boot
sector in your master image. Consult your imaging software for more details on
including the boot sector as part of the master image.

Master images should not be created if you’ve previously run Autodesk products
on the master computer. Cleaning the system may be necessary. See Clean a
Master System and Restore the Operating System.

To distribute a multi-seat stand-alone product to multiple computers using
a master image

1. Create a network deployment for a multi-seat stand-alone product. For
more information, see Use the Installation Wizard to Set Up a

Deployment.

2. Install the Autodesk product from the deployment onto the master
computer.

3. Do one of the following on the master computer:

m Create a master image, including the boot sector. Test the product
on a machine other than the master computer before distributing
the product. Launch the product on the other machine, and
register and activate it. Users have a 30-day grace period to
register and activate the product on their machines.

m Launch and customize the product as necessary. Create a master



image and distribute it to users. If users’ computers are connected
to the Internet, the product is automatically activated. Users
whose computers are not connected to the Internet have a 7-day
grace period to register and activate the product.

4. Apply the master image to the target computers.
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'se a Master Image to Distribute Network Licensed
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You can distribute the product using a master image for a network licensed
product.

To distribute a network licensed product to multiple computers using a
master image

1. Create a network deployment for a network licensed product. For more
information, see Use the Installation Wizard to Set Up a Deployment.

2. Install the Autodesk product from the deployment onto the master
computer.

Note A license server must be running, and each computer must be
connected to the network in order for the product to obtain a license.

3. After the Autodesk product has been installed, use imaging software to
create a master image of the system's hard drive.

4. Apply the master image to the target computers.
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The following procedure assumes that you have saved a copy of each
workstation’s Software Licenses folder (and Product Licenses folder, if present)
to either another workstation or a DVD before you reformat the workstation.

To restore a product using a master image

1.

Exit the application. Do not run the application again until after you have
completed this procedure.

In Windows Explorer, copy the Software Licenses folder from the
appropriate path shown below to a location other than the disk that will
be restored.

C:\Documents and Settings\All Users\Application
Data\Autodesk\Software Licenses

Reformat the workstation and restore the master image.
Note Do not perform a low-level format of the hard drive.

Copy the Software Licenses folder that you created in step 2 to its
original workstation and location on that workstation.

Note When you restore the disk image, any files that were altered are put back in
their original state and ready to use again. The license files are preserved, and no
reactivation of products is necessary.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

utoCAD Land Desktop 2009 Network Administrator's Guide > Distribute the
‘oduct Using Imaging Software >

lean a Master System and Restore the Operating System

If you have already run the Autodesk product on the master computer, the master
computer should be properly cleaned first.

To clean a master computer and restore the operating system

1. Clean the hard drive, including the boot sector.

For example, if you use Norton’s GDISK utility, use the following
command:

gdisk 1 /diskwipe

Where 1 is the hard disk that is being wiped.

Note If you use a utility other than Norton Ghost, make sure that it cleans
the boot sector; otherwise, you will not be able to activate Autodesk
products.

2. Create a new partition and use the restore CD or product CD to install
the operating system.
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activate

Part of the Autodesk software registration process, it allows you to run a
product in compliance with the product's end-user license agreement.

Active Directory

A directory service from Microsoft that is part of Windows 2000 and
Windows 2003 Server.

administrative image

A collection of shared file resources created by the Deployment wizard and
used by deployments to install the program to network workstations. Service
packs (patches) can be applied to an administrative image using the
Deployment wizard.

advertising

A pull technology that notifies users of an updated software product that is
available for installation. Users typically double-click a shortcut (or do a
similar operation) to complete the installation of the advertised product.

AutoCAD startup accelerator (acstartl7.exe)
A runtime process that can accelerate the initial startup of AutoCAD Land
Desktop.

deploy

The process of installing an Autodesk product to one or more computers on a
network.

deployment

A link to a unique MST (Microsoft Transform) file that serves as a basis for
an installation. Using the Deployment wizard, administrators can create



multiple deployments that result in different types of installations for users.

directory service

A network service that identifies all resources on a network and makes them
accessible to users and applications. Resources include email addresses,
computers, and peripheral devices such as printers. Ideally, the directory
service should make the physical network topology and protocols transparent
so that a user on a network can access any resource without knowing where
or how it is physically connected. Virtually all directory services are based on
the X.500 ITU standard.

FLEXIm

License management technology from Macrovision Software, Inc. FLEXIm
provides administrative tools that help to simplify management of network
licenses. FLEXIm can be used to monitor network license status, reset
licenses lost to a system failure, troubleshoot license servers, and update
existing license files.

group policy
Microsoft server technology that provides a way to do push installations and

advertising-based installations using standard Microsoft 2000 Server
administration components.

installation image
A deployment that consists of an MSI file, any associated transforms,
additional user-specified custom files, and profile and registry settings.

MSI

Microsoft installer that supports a variety of parameters that can be scripted.

MSP

Microsoft patch file (see patch).

MST

Microsoft transform file. Modifies the components installed by the MSI file.
For example, the Deployment wizard creates an MST file with the settings
that you specify. The deployment created by the Deployment wizard uses the
MST file in conjunction with the MSI file and MSIEXEC to install the
program on local workstations.



multi-seat stand-alone installation
A type of installation where multiple stand-alone seats of the program are
installed using a single serial number.

partial profile

A profile that contains partial registry information corresponding to a subset
of the options available from the Files tab of the Options dialog box.

patch

A software update to an application.

power user
A user with rights to access and write to the Program Files folder and the
HKEY_Local_Machine folder of the registry.

pull technology

An installation technology that requires user interaction to complete the
installation.

push technology
An installation technology that installs files to a remote desktop without any
user interaction.

scripting
The process of using scripting languages such as VB Script to facilitate the
deployment of software packages.

service pack

Autodesk terminology for an application patch.

silent installation

An installation that proceeds without any explicit user input. No dialog boxes
are presented that require interaction from the user.

SMS

Microsoft Systems Management Server. A tool that helps administer
networked machines by allowing remote configuration, push deployments,
and user administration. SMS is an expensive technology that must be



purchased as an additional server.

transform

See MST.
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